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Satellite and GIS Database of Louisiana: A Continuation of Training 

 

 

Abstract  
   
   

The Louisiana Oil Spill Coordinator's Office (LOSCO), with the support of numerous co-
sponsors, has released two CD-ROM sets that include valuable visual and graphic data 
pertaining to the state of Louisiana. The latest CD package, entitled Louisiana GIS CD, is 
the focus of this project. This two CD-ROM set contains a digital set of 30-meter 
resolution, Landsat TM satellite imagery. The CD-ROM set also provides: (1) spatial data 
layers (place names, roads, parish boundaries, etc.) that can be displayed in conjunction 
with the satellite imagery, and (2) ArcView and Geomedia GIS software.  A satellite tour 
of Louisiana with images and text is also included, as are tutorials, metadata, and 
documentations.  

This project was a continuation of a training effort initiated in 1998 that explained how to 
use the Louisiana GIS CD. This year's training effort targeted the same user groups as did 
previous years' efforts (oil and gas personnel; federal, state and local government 
agencies; community service organizations; and educators). The training activities were 
intended for users of the Louisiana GIS CD who were not familiar with satellite digital 
data or the techniques used to access, display, and analyze the datasets. To accomplish 
our goals, a series of 12 free computer based training workshops were conducted at five 
different locations, in four cities throughout Louisiana (Baton Rouge, New Orleans, Lake 
Charles, and Monroe). The hands-on computer based training focused on applying and 
using the spatial data on the Louisiana GIS CD.  

Hardcopy educational materials were developed and distributed to all workshop 
participants in order to:  
1. assist learning during the workshop, and  
2. provide supportive/refresher training material following the workshop.  

A total of 134 participants attended the 12 free training sessions. Course evaluations were 
conducted following the training sessions, and all of the evaluations were high. Instructor 
ratings ranged from 4.56 to 4.89 an a scale of 5. Course content ratings ranged from 4.57 
to 4.67. The overall rating for course content was 4.67, and the overall rating for 
instructors was 4.80.  

 



1.0 Introduction  

       In 1999, the Louisiana Oil Spill Coordinator's Office (LOSCO) and co-sponsors 
released a second CD-ROM set of statewide geo-spatial datasets.  This set was used as 
the basis for the training provided in this project. This two CD-ROM set, entitled the 
Louisiana GIS CD, was produced in cooperation with 12 state and federal agencies. The 
Louisiana GIS CD includes 41 geo-spatial layers of information ranging from Landsat 
TM data, to geology, to threatened and endangered species, to the Geographic Names 
Information System. A listing of the data layers by type is as follows:  

RASTER: UTM Zone 15 Coordinates (meters), NAD-83 Datum, Geotiff Packbit 
Compression  

• Landsat Thematic Mapper Satellite Image (North and South)  
• National Wetlands Inventory 1988 Habitat Data  

POLYGONS: Geographic Coordinates (Decimal Degrees La/Lon), NAD-83 Datum, 
ArcView Shapefiles  

• 1:100,000 Quad Index Grid (NAD-83)  
• 1:24,000 Quad Index Grid (NAD-83)  
• Aquifer Recharge Areas  
• Coastal Land/Water Interface  
• Coastal Wetlands Conservation Plan Boundary  
• Drainage Basins and Sub-segments  
• FEMA Flood Zones (Tiled by Parish)  
• General Soil Associations  
• Geology  
• Louisiana State Boundary  
• Major Rivers and Lakes  
• Marsh Vegetation Salinity  
• Official Coastal Zone Boundary  
• Parish Political Boundaries  
• Quarter Quad Index Grid (NAD-83)  
• USGS 1:24,000 Quad Map Index  
• USGS DRG Parish Political Boundaries  
• Wildlife Management Areas  
• Wildlife Refuges  

LINES: Geographic Coordinates (Decimal Degrees La/Lon), NAD-83 Datum, ArcView 
Shapefiles  

• Astronomical High Tide Line  
• Local Roads (Tiled by Parish)  
• Navigated Waterways  
• Offshore Bathymetry  



• Power Lines  
• Primary Roads (Interstates, U.S. and State Highways)  
• Railroads  
• Stream Drainage Hydrography  

POINTS: Geographic Coordinates (Decimal Degrees La/Lon), NAD-83 Datum, ArcView 
Shapefiles  

• Abandoned Barge & Vessel Inventory  
• Abandoned Non-Hazardous Oil Field Waste Pit & Facility Inventory  
• Baseline Sampling & Analysis Field Data (1996-97, 1997-98, 1998-99)  
• Early Warning Organic Compound Detection System  
• Geographic Names Information System:  Civic Facilities, Community Features, 

Physical Landforms, Vegetation Features, Water Features  
• Pipeline Crossings  
• Oil and Gas Wells (North and South)  
• Populated Places (Cities, Towns, and Villages)  
• Seabird Colonies  

DATABASE: D-Base files  

• Pipeline Companies  
• Threatened & Endangered Species  

It is important to note that the Louisiana GIS CD-ROM set was a cooperative effort 
including both state and federal groups. The sponsors were:  

1. Louisiana Department of Environmental Quality  
2. Louisiana Department of Natural Resources  
3. Louisiana Department of Transportation and Development  
4. Louisiana Department of Wildlife and Fisheries  
5. Louisiana Oil Spill Coordinator's Office  
6. Louisiana Oil Spill Research and Development Program  
7. Louisiana State University, Department of Geography and Anthropology  
8. Louisiana State University, Louisiana Geography Education Alliance  
9. USGS National Wetlands Research Center  
10. Environmental Systems Research Institute  
11. Intergraph Corporation  

      The data on the CD-ROMs are accessible using the GIS software provided by ESRI 
(Environmental Systems Research Institute) and Intergraph Corporation. Either of these 
software packages can display spatial data, zoom in and out, perform queries, select 
features, and take measurements. The spatial data on the new CD-ROM set can also be 
imported to more advanced versions of the software to allow for more sophisticated GIS 
operations.  



      Since the target distribution groups (oil and gas industry personnel; federal, state and 
local government agencies; community service organizations; and educators) for these 
CD-ROMs were not likely to be familiar with the satellite imagery, the spatially 
referenced digital datasets, or the GIS software, we conducted a series of 12 free 
computer based training workshops in four different Louisiana cities (Baton Rouge, New 
Orleans, Lake Charles, and Monroe). The wide geographic distribution of the training 
sites provided potential participants with easy access to the training. Oil and gas industry 
and supporting business personnel were the primary groups targeted for these training 
workshops, as evidenced by the percentage of the those groups on our mailing list for 
brochures and information (see Figure 1.1).  The next largest group receiving the 
brochures was government agencies (22%), followed by education groups (7%). 
Evaluations were conducted at every session; summations are provided later in the report.  

      A comparison of Figure 1.1 with Figure 1.2 shows a shift in percent attended by 
group compared to the groups targeted by mail. As with the previous year, the major 
targeted groups (oil and gas and supporting businesses) sent lower percentages to the 
training sessions than received brochures. These groups accounted for less than 50% of 
the attendees. On the other hand, 22% of the brochures went to government agencies and 
personnel; however, 29% of the attendees were from this group. The major discrepancy 
between the percent targeted and the percent attended was the education group, which 
had an attendance percentage of over three times the percentage that received brochures. 
More specifics on the locations and dates are provided below (see "Summary of the 
Introductory and Training Sessions").  

      An important aspect of this project was the distribution of a training/instructional 
book to help aid learning during the sessions and to provide a review for the participants 
upon return to their workplaces. The instructional books had been prepared for the 
previous workshops and were revised for this project. The training booklet contained 
sections on the following subjects:  

1. remote sensing  
2. GIS Tools  
3. GIS lessons (three sections)  

      In summary, the training sessions and materials helped insure that the satellite and 
other GIS-based datasets on the Louisiana GIS CD will be utilized completely and 
effectively.  

   

2.0 Methods  

      Twelve six-hour training sessions were held between September 1999 and June 2000. 
The goal of the training was to introduce the data layers on the Louisiana GIS CD and the 
application of these datasets to the targeted groups. The sessions emphasized hands-on 
activities and use of supportive educational materials both during and after the sessions. 



The sessions began with lectures, followed by computer based demonstrations and guided 
hands-on computer based training periods.  

The targeted audiences for the training sessions included:  

1. managers and technical personnel working in the oil and gas industry,  
2. personnel in federal, state and local government (for example, the Office of 

Emergency Preparedness and extension agency personnel), and  
3. K-12 educators in Louisiana.  

      To facilitate the identification of potential participants and the sites for these 
workshops, the project personnel reviewed the following:  

1. OSRADP's mailing list,  
2. mailing lists developed during the previous year’s training project with OSRADP,  
3. oil and gas industry connections through LOSCO, and  
4. a mailing list of teacher consultants made available through LaGEA.  

      The primary target groups were contacted by mail and via personal contacts. Eight 
sessions were held at Louisiana State University. Several federal agencies and oil and gas 
companies in Louisiana helped arrange facilities for the other training sessions. The off-
campus locations that provided training facilities at no cost or low cost were the 
following:  

1. Texaco Corporation, Texaco Training Center, New Orleans, LA  
2. McNeese State University, Lake Charles, LA  
3. University of Louisiana, Monroe, LA.  

      Two two-sided, one page brochures advertising the training sessions were prepared. 
The brochures were sent in two mailings to the targeted groups. A copy of the brochure is 
provided in Appendix A. The brochures identified:  

1. who should attend,  
2. when and where the training would be held,  
3. topics to be covered in the training,  
4. a list of some potential applications of the data related to oil spill scenarios, and  
5. registration and contact information.  

      Each of the two bulk mailings sent the advertising brochures to approximately 500 
addresses. Other targeted mailings were made to selected individuals or locations. The 
mailing list is available through the Louisiana Applied and Educational Oil Spill 
Research and Development Program at Louisiana State University.  



 

   

Figure 1.1   Brochures mailed by group; two bulk mailings; 490 brochures each. 

   
   
   



 
Figure 1.2   Training session attendance by group. 

   

      Conducting the training sessions in four different cities around the state helped assure 
the widest possible information dissemination about the Louisiana GIS CD. As 
mentioned previously, Figure 1.1 provides a summary of the groups on the mailing list by 
percent. Most of the flyers were sent to businesses supporting the oil and gas industry, 
many of which are involved in oil spill cleanups. A comparison of the percentages of 
attendance by group (Figure 1.2) with Figure 1.1 indicates that more people from the 
educational and the governmental groups attended than received the brochure. The 
educational group represented 22% of the total attendees, which is more than three times 
the percentage (7%) of those who received the brochure. On the reverse end, 51% of the 
brochures went to supporting businesses, but they only represented 30% of the total 
attendees. More government groups attended (29%) than received brochures (22%), but 
by only a small percentage. The oil and gas group received 18% of the brochures; 18% of 
the attendees were from that group.  

      Understanding why the highest ratio of brochures sent/attendees was recorded with 
the educational group (+3 times) and the lowest was with the supporting business group 
(-1.7 times) is not completely resolved. However, several comments can be made. First, 
the group of educators on the mailing list represented a more focused and interested pool 
of potential attendees. The mailing to the supporting business group may have included 



recipients who were not interested in the technical applications of Louisiana satellite 
imagery or the accompanying geo-spatial databases.  

      The general outline for the 12 six-hour training sessions is provided in Table 2.1. This 
outline was modified to include suggestions from past participants and includes the name 
of the training section leader.  

 
Table 2.1    Louisiana Oil Spill CD Training Topics To Be Covered 

1. INTRODUCTION - DeWitt Braud  

A. Geographic Information System  

Real World Location Coordinates  
Spatial Features Linked to Database Attributes  
Intelligent Data  
Display, Query, Analytic Functions 

B. ArcView Project  
Open Project  
Stores Document List, Data Location, Organization, Display Characteristics  
Changes Can Be Saved to New Project 

C. ArcView Windows  
Project Window Contains Document List  

View  
Table  
Chart  
Layout  
Script 

View Window  
Bubble Help  
Button Help Description 

 Use Help Button for Explanation of Buttons 
2. VIEW - DeWitt Braud  
* Pull-Down Menu Name » Function Name  

A. Properties: Reset to Feet  

View » Properties*  
Map Units [meters]  
Distance Units [feet]  
Do Not Change Projection 

B. Table of Contents  
Themes/Layers  
Points, Lines, Polygons, Rasters (images)  



Features, Symbols  
Review List of Themes 

Display on/off  
Points: Vegetation 

Lines: Interstate, Pointe Coupee Roads  
Polygons: Parishes: Filled, Outline  
Image: Pointe Coupee 

Theme Activation 
Display Facilities  
Activate Facilities  
Open DataBase Table  

Attributes Linked to Spatial Feature [Intelligent Data] 
Functions Change for Active Window 

Theme Overlay Order 
Display Parish Outlines and Soil Themes  
Drag Parish Outline Under Soils To Hide, Then Reset 

Legend Editor 
Control Symbology, Color, Fill, Pattern, Transparency, Outline  
Apply Unique Colors to Facility Types  
Double Click Theme Facilities  

Legend Type [Unique Value]  
Values Field [Type]  
Apply  
Display 

Apply Unique Colors to Soil Associations  
Double Click Soils Theme 

Legend Type [Unique Value]  
Values Field [Associated]  
Apply  
Display  
Theme » Hide Legend 

Text Labels  
Window » Show Symbol Window  

ABC: Set Size 10  
x Dismiss Window 

Display Parish Theme  
Activate Parish Theme  
Theme » Auto-Label  

Allow Overlapping Labels 
Theme » Remove Labels  
Add Theme East Baton Rouge Parish Image  

View » Add Theme  
Set Image Data Source 

Navigate and Select EBR Parish tif File  
Drag to Proper Order in Table of Contents  
Display 



Tiling: By Parish 
3. FUNCTIONS - DeWitt Braud  

A. Zoom  

Zoom Tool (in/out): From Point, Box, From View Center  
Activate Parish Theme  
Reset Zoom to Active Theme Parishes  

Select Feature in Active Theme (Parishes) with Selection Tool  

Click or Draw Selection Box in Desired Parish(es)  
Select Point Coupee Parish  
Verify Selection: Open Theme Table  

Scroll To Find Highlighted Record or Promote to Top 
Zoom to Selected Parish: Pointe Coupee  

Zoom to Theme St. Mary Parish Image  

Turn on Image  
Turn on Roads 

Zoom In to Town of Franklin using Box  
Display St. Mary Image à Note value of Image Background  

Get Lat/Lon of Point 
B. Feature ID of Active Theme  

Activate Parishes: i dentify  
Activate Roads: i dentify  
Turn on Community Theme  
Activate Community: i dentify  
Activate Quad24 Theme: i dentify (undisplayed)  

  

C. Feature Query: Selection and Location Using Criteria  
Reset Selection Color to Bright Green 

Activate Project Window  
Project » Properties 

Set Selection Color 
Find and Highlight Location of Road  

Display St. Mary Parish Roads  
Activate St. Mary Parish Roads Theme 

Query Builder ( [Fename] = "La Hwy 70")  
Construct Query:  

Check Update Values Box  
Click "Fename" from Fields List to Update Values  
Double Click "Fename" from Field List to Build Query  



Click = Operation Box  
Scroll Through Values List and Double Click "La Hwy 70"  
Click New Set 

Zoom to Selected Feature  
View Relocates to Morgan City and Centers on Highway 
70 

Relocate View to Town of Franklin  
Activate Community Theme  
Query Builder ( [Name] = "Franklin" )  
Zoom to Selected View is Positioned To Franklin 

D. Proximity Buffer  
Identify and Select Roads within 1000’ Radius of Franklin Senior High 
School  

Activate Community Theme  
Select School  
Query Builder ( [Name]= "Franklin Senior High School" )  
Activate St. Mary Parish Roads Theme  
Theme » Select by Theme  

Select Features of Active Theme (Roads) That  
[are within a distance of] 

The Selected Features of  
[Community] 

Selection Distance [1000]ft  
New Set 

Open Theme Table for Roads  
Promote Selected Records to Top 

Identify and Select Community & Facility Features Within 2 mile Radius 
of  

latitude/longitude Point 
Set lat/lon Point (Use TableX Theme for now) May Need to Zoom 
Out  
Activate Community and Facilities Themes  
Draw 2 Mile Radius Circle from Point using Graphic Circle  

Make Sure Graphic is Selected [brackets] 
Select Features Using Graphic  
Open Theme Table and Promote Records 

Identify Schools Within the Two Mile Radius  
Activate Community Theme  
Query Builder ( [Type] = "school" )  

Select from Set 
Open Theme Table and Promote Records  
Save Community Theme With Selected Records as New Theme 

Export Selected Records in Table to ASCII file  
Active Table Community  
File » Export  

Delimited Text 



Open in Notepad 
E. Overlay  

Find Seabirds in Terrebonne Parish  
Activate Parish Theme  
Select Feature Terrebonne Parish  
Zoom to Selected Terrebonne  
Activate Seabirds Theme  
Theme » Select by Theme  

 Select Features of Active Theme (Seabirds) That  
[intersect] 

The Selected Features of  
[parishes] 

F. Measurement  
How much boom is Needed to Contain a Hypothetical Spill?  

 Activate Iberia Parish Image Theme  
Zoom to Active Theme and Turn on Iberia Parish Image  
Zoom In to Weeks Island Vicinity  
Draw Point at Oil Spill Location near Weeks  

Assume SW Wind and Drift 
Draw Boom (graphic line) to Contain Spill Movement  

Color Boom Red 
Window » Show Symbol Window  

Select Red Color from Palette 
Measure Length of Boom: Read Length in Lower Left of View  

Determine Radius of Weeks Island  

Draw Circle from Center: Read Radius in Lower Left of View 
G. Add Event Theme  

Activate Project Window  
 Select Table Document  
Add Table: Specify Delimited Text  

Select Table 970703_1.txt from CD 
Activate View 2>  
View » Add Event Theme  

Table 970703_1.txt  
X Field: utm_east_27 

Y Field: utm_north_27 
Display and Activate New Theme  
Zoom to Active Theme 

H. Summarize Field  

                    Activate 1999 Field Data Theme  
                                Open Theme Table  
                                Activate Parish Name Field  
                                        Field » Summarize  



                                                    Choose Water Salinity  
                                                    Average  
                                                    Add/OK  
                                Summary Table Shows Average Salinity by Parish  

I. Theme Attribute Display  

Display Parish Population with Color Ramp  
Double Click Parish Theme to Display Legend  

Legend Type: Graduated Color  
Classification Field: Pop_94  
Do Not Normalize  
Classify: Natural Breaks  
Color Ramp: Red Chromatic  
Apply 

Select all Parishes >= 100K Population  
Activate Parish Theme  
Query Builder Pop_94 >= 100,000  
New Set 

Create Chart From Active Table window  
Table » Chart  

 Field: Pop_94  
Label Series using [Parish]  
Add  
OK 

J. Link Tables  
Open Theme Table  
            Parish Boundaries  
            Co-Parish  
            Pipeline Companies  
            Link the 3 Tables in One Direction:  
            Select Parish Field in both Parish Boundaries & Co-Parish Tables  
                    Activate Parish Boundaries  
                    Table » Link  
            Select Fname Field in both Co-Parish & Pipeline Comapnies 
Tables  
                    Activate Co-Parish Boundaries  
                    Table » Link  

            Link the 3 Tables in the Opposite Direction:  
            Select Fname Field in both Co-Parish  & Pipeline Comapnies 
Tables  
                    Activate Pipeline Companies Tables  
                    Table » Link  
            Select Parish Field in both Parish Boundaries & Co-Parish Tables  
                    Activate Co-Parish Table  



                    Table » Link  
Select a Pipeline Company from the Pipeline TAble to highlight parishes 
in the view that the selected company operates.  
Select a Parish in the view to highlight pipeline companies in the table that 
operate in the selected parish.  
  

 

3.0 Relevance  

        The recent release of the Louisiana GIS CD, developed under the direction of 
DeWitt Braud and distributed via LOSCO, has provided managers and personnel in state 
and federal agencies, industry, local government, and the educational community with an 
extremely valuable tool for visual displays, GIS-based analysis and research, and training 
of both adults and children. These CD-ROMs and the accompanying free software, along 
with the widespread availability of connections to the Internet, can facilitate 
communication and coordination of a wide range of activities, from resource 
management to emergency planning and response. Even though similar datasets have 
been released, relatively few people in Louisiana have the knowledge or experience 
needed to make the best use of the Louisiana GIS CD. Without training or technical 
assistance, many potential users will never use the datasets provided on this CD-ROM 
set. Very few industry, government, or service personnel have been exposed to either the 
type of spatial data on these CD-ROMs or the techniques necessary to view, analyze, 
query, and create maps with these datasets. Even fewer of our educators have the skills 
necessary to train or teach others how to access and utilize these datasets. These 12 six-
hour training sessions educated 134 people in Louisiana about satellite spatial datasets 
and the 41 attached GIS information layers on the Louisiana GIS CD.  

   

4.0 Work Plan and Time Schedule  

       Two of the investigators (Braud and Peele) involved in this project directed the 
preparation and production of many of the geo-spatial datasets used in the project. They 
both have considerable experience using GIS software. DeWitt Braud was the project 
manager of the Louisiana GIS CD. The other two project investigators (Peele and Lewis) 
were also major contributors to the Louisiana GIS CD. Their expertise allowed the 
principal and co-principal investigators to focus on the central theme of this project ( i.e. 
training others to utilize the datasets). The main parts of the workplan included:  

1. receiving and establishing the budget and project at Louisiana State University,  
2. revising some of the instructional materials,  
3. contacting potentially interested parties, including oil industry personnel federal, 

state and local governments agencies; community service organizations; and 
educators,  



4. selecting locations throughout Louisiana for the training sessions,  
5. presenting the training sessions,  
6. evaluating the training sessions via questionnaires, and  
7. producing quarterly reports and a final report.  

       The project was conducted over a 15 month period (May 1, 1999 through August 31, 
2000). The workplan consisted of the elements noted in Table 4.1 and Figure 4.1.  

 
Table 4.1    Project Work Plan of Activities Sequenced by Time 

May 1999....... Secure funding and establish contract budget codes.  

May 1999....... Subcontract staff responsible for arranging sessions.  

May 1999....... Hire undergraduate student to copy educational material and 
support other  

    activities related to the training sessions.  
  

May 1999....... Contact sources that can provide potential groups and locations for 
training sessions.  

May 1999....... Finalize the instructional material and practice upcoming 
presentations.  

June 1999....... Prepare workshop brochure and mailing list.  

July 1999........ Mail out brochures and schedule workshops.  

Sept 1999....... Present first six-hour training session at Pleasant Hall, LSU, Baton 
Rouge.  

Nov 1999....... Present second six-hour training session at Pleasant Hall, LSU, 
Baton Rouge.  

Dec 1999........ Present third six-hour training session at Pleasant Hall, LSU, 
Baton Rouge.  

Jan 2000......... Present fourth six-hour training session at Pleasant Hall, LSU, 
Baton Rouge.  

Feb 2000........ Present fifth six-hour training session McNeese University, Lake 
Charles.  

Mar 2000........ Present sixth six-hour training session at Pleasant Hall, LSU, 
Baton Rouge.  



Mar 2000........ Present seventh six-hour training session at Texaco Training 
Center, New Orleans.  

Mar 2000........ Present eighth six-hour training session at Texaco Training Center, 
New Orleans.  

1999 2000 

Task May Jun Jul Aug Sep Oct Nov  Dec Jan Feb Mar Apr May June Jul Aug 

A n                

B n                

C n                

D n                

E n                
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I       n          

J        n         
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L          n       

M          n       

N          n       

O           n      

P            n     

Q             n    



Apr 2000........ Present ninth six-hour training session at University of Louisiana, 
Monroe.  

R             n    

S               n  

T                n 

June 2000....... Present tenth six-hour training session at CADGIS, LSU, Baton 
Rouge.  

June 2000....... Present eleventh six-hour training session at CADGIS, LSU, Baton 
Rouge.  

July 2000........ Present twelth six-hour training session at Pleasant Hall, LSU, 
Baton Rouge.  

Aug 2000........ Prepare final report. 

 

   

Task Descriptions  

A........ Secure funding and establish contract budget codes.  

B......... Subcontract staff responsible for arranging sessions.  

C........ Hire undergraduate student to copy educational material and support other 
activities related to the training  

  sessions.  
  

D........ Contact sources that can provide potential groups and locations for 
training sessions.  

E......... Finalize the instructional material and practice upcoming presentations.  

F......... Prepare workshop brochure and mailing list.  

G........ Mail out brochures and schedule workshops.  

H........ Present first six-hour training session at Pleasant Hall, LSU, Baton Rouge.  



I.......... Present second six-hour training session at Pleasant Hall, LSU, Baton 
Rouge.  

J.......... Present third six-hour training session at Pleasant Hall, LSU, Baton 
Rouge.  

K........ Present fourth six-hour training session at Pleasant Hall, LSU, Baton 
Rouge.  

L......... Present fifth six-hour training session McNeese University, Lake Charles.  

M........ Present sixth six-hour training session at Pleasant Hall, LSU, Baton 
Rouge.  

N........ Present seventh six-hour training session at Texaco Training Center, New 
Orleans.  

O........ Present eighth six-hour training session at Texaco Training Center, New 
Orleans.  

P......... Present ninth six-hour training session at University of Louisiana, 
Monroe.  

Q........ Present tenth six-hour training session at CADGIS, LSU, Baton Rouge.  

R......... Present eleventh six-hour training session at CADGIS, LSU, Baton 
Rouge.  

S......... Present twelth six-hour training session at Pleasant Hall, LSU, Baton 
Rouge.  

T......... Prepare final report. 

Figure 4.1    Event-flow diagram. 

   

        The workplan/time schedule was organized around the optimum time for potential 
participant availability, the working schedule of the three project investigators, the 
project funding schedule, and the availability of computer training facilities. During the 
first four months of the project (May through August), the training sessions were 
organized, instructional materials revised, the locations of approximately half of the 
training sites determined, and the logistical support for the training sessions arranged. 
DeWitt Braud conducted almost all of the training sessions, with assistance from 
Hampton Peele. Experience from the previous year of training sessions had indicated the 
need for an assistant who circulated around the lab and assisted those in need. At least 



two instructors were present at every training session. As indicated in the outline of 
lecture material, DeWitt Braud handled the bulk of the lecturing.  

   

   

5.0 Deliverables/Final Products  

        During the course of this project, the Louisiana GIS CD was not available, and a 
training version was utilized as the primary teaching tool. An instruction manual, 
developed last year, was revised and used to complement the training sessions. Every 
participant received a copy of this manual along with the two-CD set to help support 
continued learning upon the participant’s return to the workplace. The distributed manual 
entitled, An Introduction to Louisiana GIS CD: Remote Sensing and GIS Training is a 
loose-leaf bound document with five sections. The sections are entitled:  

1. Remote sensing  
2. GIS - tools  
3. GIS - Lesson 1  
4. GIS - Lesson 2  
5. GIS - Lesson 3  

       A detailed outline, covering each step required to complete a demonstrated procedure 
was provided in the manual (see Table 2.1). The three sections of GIS lessons in the 
manual, provided by ESRI, helped support the outlined instructions after the participants 
completed the training sessions. Three copies of this training/instructional manual are 
included, under separate cover, as part of the final report.  

   

6.0 Summary of Introductory and Training Sessions  

6.1 Locations and Dates  

       The arrangement of locations and dates for the computer training was problematic 
for several reasons:  

1. It was difficult to find facilities with enough suitable computers.  
2. Many suitable facilities were already reserved.  
3. Oil companies have reduced funding for training facilities.  

       Figure 6.1 provides the locations and dates for the workshops. Six of the 12 sessions 
were held at the computer training facility of the Department of Continuing Education at 
Louisiana State University in Baton Rouge. Two more sessions were held at the 
Louisiana State University Department of Geography and Anthropology’s CADGIS Lab. 



These eight training sessions were spread over seven months. The remaining four training 
sessions were held outside Baton Rouge.  One session was held in February, two in 
March, and one in April. The first session was held at McNeese State University in Lake 
Charles. The next two were held at the Texaco Training Center in New Orleans. The last 
training session outside of Baton Rouge was held at the University of Louisiana in 
Monroe.  

6.2 Workshop Registration and Attendance  

       Interest in the workshops was high. This statement is supported by the high 
percentage of participant pre-registration. Most of the training sessions were either fully 
booked or over-booked. The number of permitted reservations depended on the location 
of the training facility, the number of computers committed to the training session, and 
the number of participants allocated to each computer. Although not always possible, we 
tried to have only one person at each computer. The number of reservations given in 
Figure 6.2 sometimes represents greater than 100% of the possible available slots with 
the anticipation of some "no-shows."  

       Attendance at the training sessions was much improved over the previous year when 
our percentage of "no-shows" was 34%. This year the percentage of "no-shows" dropped 
to approximately 9%. This dramatic increase in attendance was largely due to our new 
policy of contacting the registrants a week prior to the training session and getting a 
verbal commitment as to whether they would attend. If they were not able to attend, we 
had time to fill their vacant training slot.  

6.3 Course Evaluations  

       A standard evaluation form, developed by LSU Continuing Education, was provided 
to every participant. Nearly every participant completed the form. The participants were 
asked to evaluate the course instructors (Table 6.1) and the course content (Table 6.2). 
On a scale of 1 to 5, with 5 being the highest ranking, the instructors' evaluations ranged 
from 4.56 to 4.89.  The overall instructor rating was 4.80. Although we realize that the 
instructor evaluations are excellent, we understand that there are many ways to improve 
on the course.  

       Evaluations of the course content were not quite as high, but still very good, ranging 
from 4.57 to 4.67.  The overall rating was 4.67. Figure 6.3 shows a list of the comment 
questions that the participants were asked to answer. Table 6.3 is a summary of their 
responses to those questions. It is satisfying that 93.5% of the participants felt the course 
was at the right level, and that 100% of them would recommend the training to others. 
This response affirms that we were providing valuable information and training to the 
participants. Another interesting comment was that 28% thought that the course could be 
improved by extending the time, even though the course was two hours longer than last 
year's training sessions. Almost 60% of those attending the training sessions learned 
about the training by word of mouth, and 34% learned about the course through the 
brochures we distributed. Our first interpretation of these results was that our bulk 



mailings were not reaching the correct personnel. However, we now believe that the 
brochures were a good source of course information, and that some who received the 
brochures passed on the information to others who attended the sessions.  

   

Figure 6.1 

Location and Dates of Workshops 

LSU, Continuing Education   
Baton Rouge, LA   
September 28, 1999   
November 2, 1999   
December 14,1999   
January 18, 2000   
March 10, 2000   
July 6, 2000 

Texaco Training Center  
New Orleans, LA   
March 16, 2000   
March 17, 2000 

McNeese University   
Lake Charles, LA   
February 25, 2000 

University of Louisiana  
Monroe, LA   
April 25, 2000 

LSU, CADGIS Lab   
Baton Rouge, LA   
June 12, 2000   
June 13, 2000 

   

Figure 6.1    Location and dates of workshops. 

   

Figure 6.2 

WORKSHOP ATTENDANCE 

Date Reservations Attendance Percent No Shows 

September 28, 1999 11 10 9% 

November 2, 1999 12 12 0% 



December 14, 1999 14 9 36% 

January 28, 2000 11 9 18% 

February 25, 2000 15 17 0% 

March 10, 2000 12 10 17% 

March 16, 2000 10 12 0% 

March 17, 2000 7 7 0% 

April 14, 2000 6 7 0% 

June 12, 2000 17 14 18% 

June 13, 2000 17 14 18% 

July 6, 2000 15 13 13% 

Total 147 134 ~9% 

Figure 6.2    Workshop attendance. 

   

 
Table 6.1    Evaluation Summary: Course Instructor 
EVALUATION SUMMARY: COURSE INSTRUCTOR 

1. Knowledge of subject matter.         4.89 
2. Effectiveness of presentation.         4.65 
3. Rapport with the class.                   4.59 
4. Effective use of class time.             4.70 
5. Quality of handouts/visuals.            4.56 
6. Overall rating of instructor.             4.80 

   
Table 6.2    Evaluation Summary: Course Content 
EVALUATION SUMMARY: COURSE CONTENT 

1. Description of course.               4.61 
2. Organization of course.              4.57 
3. Goals of course achieved.         4.59 
4. Overall rating of content.           4.67 



 

   

Comment Questions 

1. At what level was the course presented?  
Too Advanced         About Right         Too elementary  
   

2. Would you recommend this course to others?  
3. Which areas of the course were most helpful?  
4. Which areas of the course were least helpful?  
5. How can the course be improved?  
6. How did you hear about this course?  

Figure 6.3    Comment Questions 

   

 
Table 6.3    Summary of Participant's Comments 

1. 4% Too advanced  
93.5% About right  
2.5% Too elementary  

2. 100% would recommend the course to others.  
3. 21.5% found the entire course most helpful.  

15% found the hands on training most helpful.  
10% found ArcView overview most helpful.  
9% found the CD features most helpful.  
8% found the map making tips most helpful.  

4. Comments included ArcView, layouts and remote sensing.  
5. 28% would like to extend the class time.  
6. 59.5% found out about the course by word of mouth.  
7. 34% found out about the course through the brochure.  

 

   

7.0 Problems Encountered  

        The problems we encountered were minimal and none prevented the successful 
completion of the project. Several problems elucidated in the previous year’s final report 
were solved. We still had to deal with significant delays in the production of the 
Louisiana GIS CD, and it did not arrive until late in the project year. The prior problem 



of "no-shows" was handled by having staff contact the registrants prior to the training. 
This technique worked well and would be a recommended action for future training 
programs.  

        Using a new computer based training facility was difficult and required several 
discussions with the facility manager as well as travelling to the facility the day before 
the training. Setting up and checking the computers the day before the actual training 
session was essential. During this preparatory check, we often found minor problems 
with the computers, that if not rectified, would have caused considerable delays the day 
of the training session. Considering the occasionally less than adequate facilities, unusual 
circumstances, and unanticipated problems that arise when teaching "on-the-road," we 
believe it is more desirable to use one facility where all the problems have been solved 
and the instructors know the equipment.  

   

8.0 Results  

        As previously mentioned, 12 training sessions were conducted at five different 
locations in four different cities. The four cities (Baton Rouge, New Orleans, Lake 
Charles, and Monroe) provided a good geographic spread around the state of Louisiana. 
Reservations were made by 147 individuals. Of these, 134 attended the 12 workshops. 
We thus only had approximately 9% "no-shows," a dramatic decrease from last year's 
34%. Course evaluations for both the instructors and course content were high for the 
second year, with 5.0 being the top score; instructors received an overall rating of 4.8.  
The overall course content received a 4.67 rating.  These scores are slightly higher than 
last year. All of the participants said they would recommend the course to others.  

   

   

 


